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License agreement

Below are the terms of the license agreement for use of the ScanEasy for HP software:

1. When not licensed, this software is provided for evaluation purposes only. You have twenty one (21) days to 
complete evaluation. After this period, should you decide not to purchase a license, this software must be 
permanently removed from your computer.

2. When licensed from Bitware Australia Pty. Ltd. or authorized suppliers, a license for use of this software is 
granted to the named licensee (or official representative in the case of a Corporate license) only.

3. This software is licensed for installation and use on a single machine (in the case of an Individual license), or 
multiple machines up to the number permitted by your license (in the case of a Corporate license). When 
installed on a file server, the number of authorized users must not exceed that permitted by your license.

4. You may make a single copy of media containing licensed materials solely for backup or archival purposes.
5. Neither Bitware Australia Pty. Ltd. or its suppliers shall be responsible for replacement of media or license 

details in the event of loss or damage other than for physical defects in original materials as supplied.
6. This software is copyright material of Bitware Australia Pty. Ltd. and is covered by international copyright laws 

and treaty provisions. You may not alter, decompile or disassemble the software.
7. You may not resell, rent, lease or otherwise transfer your license to any other party without the express 

permission of Bitware Australia Pty. Ltd.
8. This software is provided as is without any warranty, expressed or implied, including but not limited to fitness 

for a particular purpose.
9. In no event shall Bitware Australia Pty. Ltd. or its suppliers be liable for any damages whatsoever (including, 

without limitation, damages for loss of business profits, business interruption, loss of business information, or 
other pecuniary loss) arising out of use of or inability to use the software.



What is ScanEasy for HP?

ScanEasy for HP is a plug-in supporting Hewlett-Packard's family of ScanJet desktop scanners. It enables a host
application (such as Adobe Photoshop) to control scanner operation and acquire images directly from the 
scanner.

Features of ScanEasy for HP include:
· modern, efficient interface
· access to host application functions while active
· full support for bitmap, grayscale and color images
· support for 10-bit grayscale and 30-bit color modes
· live preview using the host application's monitor setup
· selection and multi-level zoom in/out
· mirror, rotation and negative options
· set brightness/contrast, remove color casts
· access to advanced scanner features
· multi-threaded 32-bit implementation for optimum performance
· pervasive online help



What scanner models does ScanEasy for HP support?

ScanEasy for HP supports the following Hewlett-Packard ScanJet models:
· ScanJet Plus
· ScanJet IIp
· ScanJet IIc
· ScanJet IIcx
· ScanJet 3p
· ScanJet 3c
· ScanJet 4c

Note that the appropriate drivers for both scanner and interface card must be installed.



What software can I use ScanEasy for HP with?

ScanEasy for HP is supported by Adobe Photoshop 3.0 (and later) and any other applications that support the 
Adobe Acquire 3.0 plug-in architecture.

The operating systems supported include Microsoft Windows 95 and Windows NT 4.0 (and later).



How does ScanEasy for HP differ from DeskScan II?

Unlike DeskScan II which ships with all ScanJets, ScanEasy for HP is not a TWAIN module but a fully contained 
Acquire plug-in. As such, it has direct access to functionality provided by the host application for better 
integration and performance.

ScanEasy for HP has a modern interface specifically designed for efficient use. It also exploits more of the 
features supported by your scanner.

ScanEasy for HP will coexist with DeskScan II.



Installing ScanEasy for HP

To install ScanEasy for HP, simply copy the following files to your plug-in directory:
· ScanEasy.8BA
· ScanEasy.HLP
· ScanEasy.CNT

You must also have installed the appropriate driver files for your HP scanner. These driver files are included in 
current DeskScan II installations. ScanEasy for HP requires (at minimum) the following files:
· HPSJ32.DLL
· HPSCNMGR.DLL
· HPSCNMGR.HLP

For Windows NT 4.0, the following ASPI driver files are required:
· ASPI32.SYS
· WNASPI32.DLL

The latest versions of these driver files are available for download from the Internet sites www.hp.com and 
www.adaptec.com respectively.



Starting ScanEasy for HP

To start ScanEasy for HP, start your host application and open the File->Acquire menu. Select ScanEasy for 
HP from the listed plug-ins.



Finding your way around ScanEasy for HP

The ScanEasy for HP interface is organized around a number of pages each of which presents a group of 
related options. You can flip from one page to another by clicking the appropriate page tab. All changes made to 
options or values on a page will be preserved when you change pages. Most settings will be saved at the 
completion of a session and restored when you next start ScanEasy for HP.

To restore all values to their default (or factory) values, click the Defaults button. Only values on the current 
page will be changed.

Some pages show a preview of the scan. You can click the mouse on the preview to set some options. The 
function of the preview depends on which page is active. For example, on the Mode/Size page, you can specify a 
selection by clicking the mouse and dragging a selection border. On other pages, you can sample the preview for
density or color.

When you first start ScanEasy for HP, an initial scan will be done so that you can see a preview of the scan. If 
you change or move the original, you will need to refresh the preview by clicking the Preview button. ScanEasy
for HP updates the preview display automatically after each change of options so you do not need to click 
Preview after each change.

After the initial preview is completed you will probably first want to make a selection of the original then adjust 
the output resolution and size. You do this on the Mode/Size page. Next, move to the Brightness/Contrast page 
and adjust the preview to give the correct tonality. Lastly, move to the Color Balance page and make any 
adjustments for color casts.

When you are happy with the preview, click the Scan button to scan the selected portion of the original into the 
host application using the options you've specified. You can now review the scanned result, make any changes 
required, and start another scan if necessary.

Click the Cancel button when you want to terminate the ScanEasy for HP session.



Getting the best possible scan using ScanEasy for HP

To get the best possible scanned result you can leverage the capabilities of powerful image editing software, 
such as Photoshop. ScanEasy for HP permits transfer of the raw scanner data to the host application for 
absolute control in the quality of the final image.

To use Photoshop for scaling of the image, set the output Resolution to the optical resolution of your scanner 
(see the Scanner page) and the Scaling to exactly 100%. This will cause your scanner to bypass its scaling 
phase. In Photoshop, use the Image Size dialog to specify the desired output dimensions and resolution. Make 
sure you have bicubic interpolation turned on in your Photoshop General Preferences dialog.

After resampling the image, you will need to sharpen your image. Select Unsharp Mask from the Filter menu. 
You can experiment to see which values give the best result. Suggested starting values for Unsharp Mask are 
100%, 1.0, 4. If the scanned image is to be printed, you may want to increase the amount of sharpening. Try not 
to resample your image after sharpening.

To use Photoshop for adjusting tonality, set the mode to the highest bit depth supported by your scanner. The 
ScanJet 3c/4c models support both 10-bit grayscale and 30-bit color modes. ScanEasy for HP can transfer this 
10-bit/30-bit data unmodified to Photoshop (where it is expanded to 16-bit/48-bit data respectively). Photoshop 
supports only limited editing in these modes. You can use Levels or Curves from the Image menu to minimize 
discontinuities in the tonal distribution. After editing, you must either convert the image to 8-bit/24-bit mode 
from the Mode menu, or Save the image in a format with supports 16-bit/48-bit images.

To have your scanner bypass tonal adjustment, set the Brightness/Contrast values to 0/0 or use a straight line 
Curve.

Lastly, if you want access the raw colors from your scanner, enable the Bypass color correction option on the 
Color Balance page. You can then use channel operations to mix the colors as desired.



Getting help while using ScanEasy for HP

Full help for ScanEasy for HP is available by clicking the question mark icon at the top right of the window and 
dropping this question mark on any item displayed.



The Mode/Size page

The Mode/Size page is where you make a selection of the original and specify the output mode, resolution and 
dimensions for the scan.

The first values you will probably want to set are the output Mode and Resolution. These depend on the 
intended use of the scan and generally will only change when a different form of output is required.

If you require output with specific dimensions, enter the desired width and height and click the Lock button. If 
not, you can adjust width and/or height later. Next, make a selection by clicking the mouse on the preview 
display and dragging the selection border. You can move the selection by clicking inside it or modify your 
selection by dragging the edges or corners of the border. Click outside the current selection to delete it and start 
a new selection.

When you are happy with the selection, you can then adjust the dimensions as required. You can do this by 
either entering exact dimensions or changing the Scaling to give the desired output size.

If you want to examine your selection in more detail, click the Zoom-in button to re-scan the original. You can 
Zoom-in as many times as you want. If you want to revert to the previous preview, click the Zoom-out button.

You can also click the Rotate, Mirror and Negative buttons to change the output result.



The Brightness/Contrast page

The Brightness/Contrast page is where you adjust the scan for tonality or brightness and contrast.

You can set tonality either by specifying Brightness and Contrast values, or modifying a Tone Curve. Which 
method get used for the scan depends on which you last selected. Click the Settings or Curve button to change
between the two.

If you specify Brightness/Contrast values of 0/0 or use a straight line curve you will get unmodified tonality. For 
most applications, this will be much too dark and have too little contrast. You can adjust the tonality by setting 
the appropriate values or manipulating the curve.

When using Settings, you can use the Autotone button to sample the current selection and generate 
Brightness/Contrast values automatically. You can then fine tune the result by moving the sliders until the 
preview looks to have the correct tonality.

When using a Curve to set tonality, you can sample the preview to set the Black and White points, then 
manipulate the curve points to give the emphasis desired.



The Color Balance page

The Color Balance page is where you can adjust for color casts in the original or introduced by the scanner 
itself.

By selecting a color to be made neutral (white or gray) you can remove color casts. To set this color, either 
sample what should be a pure white or gray in the preview or move the pointer in the color display. The preview 
will be updated to show the result of the color change. The tonality of the scan will not be affected.

By default, ScanEasy for HP is calibrated for optimal display on an average monitor.

To access the raw colors from the scanner, select the Bypass color correction option.



The Miscellaneous page

The Miscellaneous page is where you can specify a number of settings to control operation of ScanEasy for 
HP, or refine scanner operation.

The Halftone type selected here is the one that will be used when you select the Bitmap (halftone) mode.

The Smoothing setting will determine how pixels are combined when a scan is scaled down from its original 
(optical) size.

The Grayscale bias values determine how a color original is mapped to grayscale (on a color scanner).

The Lamp warm time value determines how long the scanner lamp is turned on at the start of the ScanEasy 
for HP session. This may be necessary when the scanner is used infrequently and consistent previews/scans are 
required.

The Buffer count value determines the amount of memory to be allocated to buffer the data from the scanner 
before it is transferred to the host application.



The Scanner page

The Scanner page lists the specifications and features for your scanner. All values are obtained by interrogating 
the scanner itself.



Registration information

When not licensed, this copy of ScanEasy for HP is provided for evaluation purposes only. You have twenty one 
(21) days to complete evaluation. After this period, should you decide not to purchase a license, this software 
must be permanently removed from your computer.

Licensing ScanEasy for HP for your own individual use is easy. Benefits include access to updated versions of 
the software from online services, technical support and the knowledge that you are contributing directly to the 
viability of ongoing development of this software.

When you license the software you will receive individual license details to unlock the full functionality of the 
current software. These license details will work with all subsequent versions of the software up to Version 1.99. 
Make sure you retain your license details for upgrades or should reinstallation be necessary.

If you have access to CompuServe, you can register online with GO SWREG. Follow the instructions and enter the
Registration ID 12077. License details will be sent to you via email shortly afterwards. No software will be sent. 
Registration by SWREG is available for a single license only. The license will be made out in the name specified. 
Cost for registration via SWREG is US $55. This will be charged directly to your CompuServe account.

Alternatively, complete the Order Form        and send this via:

email: CompuServe:    100033,340
Internet:    bitware@ibm.net

fax: +61-6-2810175

post: Bitware Australia Pty. Ltd.
P.O. Box 3097
Manuka    A.C.T.    2603
AUSTRALIA

Include payment (credit card particulars or check/cheque). License details will be sent in return to you via email, 
fax or post as appropriate.

As all updates to this software will be made available for download from online services, a copy of the latest 
version of the software is optional and will incur a slightly higher charge. If requested, this will be sent on 3.5 
inch floppy via post to the address you specify. Delivery (via airmail) will be approximately 2 weeks from receipt 
of your order.

Attractive pricing for Corporate (multi-user) licenses is available on request.

Conditions:
· All Individual licenses must be pre-paid.
· Use a separate Order Form for each licensee.
· All credit card orders (except email orders) must be signed by the cardholder.
· Make sure you include all digits of your credit card number. (Visa card numbers have either 13 or 16 digits. 

Mastercards always have 16 digits.) For Visa and Mastercard, your card's expiry date is required. For Amex, 
include the 4 digit identification code (non-embossed number on the face of the card).

· All credit card payments will be charged in Australian currency (AUD). US dollar equivalents quoted in the 
Order Form are approximate only and the actual amount charged may vary slightly due to currency 
fluctuations.

· Payment by cheque/check can be made in either Australian currency (drawn on an Australian bank and 
branch), in US currency or any other currency at current exchange rates. In each case, the currency must 
match the country of origin of the cheque/check (e.g. US dollars drawn on a branch of a US bank).

· Eurocheques or Postal Orders cannot be accepted.
· Quoted prices are exclusive of local taxes, customs duty etc. The licensee shall be solely responsible for 

payment of such taxes (where applicable).





Technical support via CompuServe

Technical support for registered users of ScanEasy for HP is available by email on CompuServe. Make sure you 
have first read all documentation and online help provided.

Send your query to id 100033,340. Include "ScanEasy" in the message title.

Includes details on:
· The version number for ScanEasy for HP (select About Plug-in from the host application Help menu).
· The host application name and version.
· The operating system and version.
· Your scanner model and features.



Technical support via Internet

Technical support for registered users of ScanEasy for HP is available by email on the Internet. Make sure you 
have first read all documentation and online help provided.

Send your query to bitware@ibm.net. Include "ScanEasy" in the message title.

Includes details on:
· The version number for ScanEasy for HP (select About Plug-in from the host application Help menu).
· The host application name and version.
· The operating system and version.
· Your scanner model and features.



                    ScanEasy for HP - ORDER FORM

   Name:  _____________________________________________________________

Company:  _____________________________________________________________

Address:  _____________________________________________________________

          _____________________________________________________________

          _____________________________________________________________

          _____________________________________________________________

  Phone:  _________________________    Fax:  __________________________

  Email:  _____________________________________________________________

                              Select one:

__ Individual license (no floppy) _____________ AUD $69 (US $55) ______

__ Individual license (floppy) ________________ AUD $79 (US $63) ______

Enclose cheque/check for the appropriate amount above (or converted
equivalent), or complete credit card details:

      Credit card:  ___ Mastercard     ___ Visa     ___ Amex id: ______

      Card number:  ________________________________   Expiry:  __ / __

Cardholder's name:  ___________________________________________________

        Signature:  ___________________________________________________



                                                       Revised: 7/96



Click the Scan button to initiate the scan. The variables used for the scan will be those specified on all pages.



Click the Preview button to display a preview of the scanned image. When a selection has been made, this 
selection will be discarded and a scan of the full image area done. As the preview is dynamically updated for 
each change made to scan settings, it is only necessary to initiate a new preview when the original has been 
changed or moved.



Click the Cancel button to terminate the scanning session. All changes to scan variables will be preserved.



Click the Defaults button to restore settings on the current page to their default (factory) values. Only values on
the currently displayed page will be affected.



Click the Help button to display general help about the application.



The settings for the scan are split over a number of pages. Click the tab of the page with the desired set of 
options.

The Mode/Size page is where you specify the output mode, resolution and scaling for the scan. You can also use
this page to specify a selection of the preview and zoom in/out.
The Brightness/Contrast page is where you specify tonal values for the scan. This can either be single value 
brightness/contrast settings or a tone curve.
The Color Balance page is where you select a color from the preview to be made neutral (white or gray).
The Miscellaneous page is where sundry settings can be made. This include halftone patterns, smoothing, 
grayscale bias, units, lamp warm time and buffer count values.
The Scanner page lists specifications and features for the scanner.
The Registration page shows your current registration status.



This is the preview display. It is updated dynamically to reflect the current scan settings. Depending on which 
page is currently displayed, you can use this preview to specify (with the mouse) a selection, or sample the 
image for black/white points, neutral color etc. To refresh the display after the original has been changed or 
moved, click the Preview button.



Select the desired output Mode from the drop-down list. The preview will be updated to reflect the mode 
specified.

Modes include:
· Bitmap (threshold) - select this when the original is text, line art.
· Bitmap (halftone) - select this when the original is continuous tone and B&W output is desired. The pattern 

to be used for the halftone can be selected from the Miscellaneous page. Alternatively, scan as Grayscale and 
apply an error diffusion dither (or similar) from the host application to render the image as B&W.

· Grayscale - select this when the original is continuous tone and grayscale output is desired.
· Grayscale (10-bit) - select this when you want the maximum amount of grayscale information from your 

scanner (on later scanner models).
· RGB Color - select this for color originals. The output will be 24-bit color.
· RGB Color (30-bit) - select this when you want the maximum amount of color information from your scanner 

(on later scanner models).

Note: to be available for selection, the mode must be supported by both your scanner and the host application.



Enter the desired output Resolution (in dpi). This resolution will depend on the intended usage of the scanned 
image.

Note that the resolution used for the scan itself will depend on both output resolution and scaling. The current 
scaling may be changed as some combinations of resolution and scaling may not be supported by the scanner.



Specify the exact output Dimensions desired. The preview will be updated to show the current selection.

Note that the specified dimension may be altered slightly, depending on resolution, scaling and selection.



If you click the Lock button, the current dimensions will be locked. If you then change the Scaling, the selection 
will be modified whilst preserving the current dimensions.



Select the Units in which you want the output dimensions to be displayed.



You can specify the output dimensions as a percentage Scaling of the original (or selected part thereof). At 
100% scaling the dimensions of the scan will be identical to that of the original, irrespective of resolution.

Some combinations of resolution and scaling may not be supported by the scanner.



This is the estimated size of the scanned image. The time to complete the scan will be roughly proportional to 
this size.



Click the Mirror button to horizontally flip the output.



Click the Rotate button to rotate the output 90 degrees counter-clockwise. The preview display will not reflect 
this setting.



Click the Negative button to invert the output tones/colors.



Click the Zoom-in/Zoom-out buttons to update the preview display. Zooming in will re-scan the original 
depending on the current selection. Zooming out will restore the preview display to its prior state. You can zoom 
in and out a number of levels. The corresponding button will only be available if a selection has been made and a
prior state exists.

Note that it is not necessary to zoom in after a selection has been made. When scanning, the current selection 
will determine the output.



Specify the Brightness for the scan. Moving the slider to the right or entering a positive value will increase 
brightness. Moving the slider to the left or entering a negative value will decrease brightness. To set the 
brightness (and contrast) value automatically, click the Autotone button. Alternatively, click the Curve button 
to manipulate the tone curve.



Specify the Contrast for the scan. Moving the slider to the right or entering a positive value will increase 
contrast. Moving the slider to the left or entering a negative value will decrease contrast. To set the contrast (and
brightness) value automatically, click the Autotone button. Alternatively, click the Curve button to manipulate 
the tone curve.



This is the tone Curve. You can use this to set the tonal values for the scan. Modifying the curve gives you more 
control than just setting single brightness/contrast values and is recommended if you want to make modifications
to just a part of the tonal range. To modify the curve, click the anchor points and drag them to the desired 
position. Moving the anchor point up/down will lighten/darken the output respectively. Making the curve 
steeper/flatter will increase/decrease contrast.



This is a before/after readout of the percentage Black in the image at the point currently under the mouse 
pointer.



Click the Settings button to specify the brightness and contrast by value.



Click the Curve button to specify the brightness and contrast by manipulating the tone curve.



Click the Autotone button to automatically set the brightness and contrast values for the scan. The preview (or 
selection thereof) will be sampled to determine these settings. For best results, make sure a representative 
portion of the preview image is selected before invoking this function.



Click the Blackpoint/Whitepoint buttons to specify whether you are setting the black or white point for the 
tone curve. To set the black/white point, sample the preview by clicking the mouse on the darkest/lightest part of
the displayed image respectively. The end points for the tone curve will be set accordingly..



When Bitmap (halftone) mode is selected, one of the listed Halftone patterns will be used to dither the image.
Select the desired pattern. Note that preview display will appear a lot coarser than the scanned result.



When the output image size is smaller than the scan size (at the optical resolution) a number of input pixels will 
be combined to generate the output result. If the Auto value is selected, the scanner will automatically select 
the optimum smoothing setting for the current scaling factor.



To have the scanner lamp turned on for a set period of time every time the plugin is invoked, specify a non-zero 
Lamp warm time value. Warming the lamp prior to a preview/scan may give more accurate and consistent 
results if the scanner is used infrequently.



The Grayscale bias values determine the relative lightness/darkness of colors when an original is scanned on a 
color scanner and Bitmap (halftone) or Grayscale output mode is specified. A higher value for a color will 
result in a darker result for areas of the original with that color. In general, the default settings will give the most 
natural conversion for continuous tone originals.



The Buffer count value determines the total amount of storage to be allocated to buffer the data from the 
scanner before it is transferred to the host application. Each buffer uses 64KB of memory. If you have a limited 
amount of memory available you may want to reduce this value.



The Neutral color display provides a means to set a color from the image that should be white (or neutral) on 
output. This enables color casts either inherent to the scanner or in the original to be removed or reduced. A 
small circle shows the current color selected. You can manually move the selection by dragging it with the 
mouse. Alternatively, you can sample a white or gray from the preview display. The preview will be updated to 
display the updated colors.



The RGB/HSV values displayed are those of the color designated to be made neutral. Both sets of values 
represent the same color but in different color spaces. Note that the V (Value) component of the color is not used
in generating the output transform.



Select Bypass color correction to deliver the raw color data from the scanner to the host application.



The Scanner page lists the specifications and features for your scanner. These values are generated by 
interrogating the scanner itself.
The Model is the scanner model.
The Type of scanner is either grayscale or color.
The Maximum bit depth is the number of bits supported by the scanner for grayscale and color respectively. A 
higher capability in the scanner hardware means that a greater density range is supported.
The Optical resolution of the scanner is the resolution (in dpi) of the CCD used for the scan. In general, a 
higher optical resolution will enable the scanner to resolve more detail in the original.
The Selectable resolution is the range of output resolutions supported by the scanner. The actual resolution 
range supported for a scan will depend on the output scaling selected. The scanner may either interpolate or 
smooth raw scanned data to generate output at a specified resolution/scaling.
The Scaling is a range of scaling values that may be specified for a scan. The actual scaling range supported for 
a scan will depend on the output resolution selected.
The Maximum scan area is the maximum dimensions of an original supported by the scanner.
The Features indicate whether an Auto Document Feeder or Transparency Adapter has been detected for this 
scanner.



If you have registered this software, enter your License name and License number exactly as given in the 
respective fields and click the Validate license details button. These details will be retained for future 
sessions.

If you have not yet registered, enter DEMO in the License name field. For information on registration, click the 
Registration help button.






